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1 Introduction 

A new connectivity framework known as CoreCon can establish a connection between your 
Zoom™ OMAP35x Development Kit running Windows Embedded CE 6.0 (CE 6.0) and your 
Visual Studio 2005 (VS2005) development system. Establishing this connection allows you to 
download custom VS2005 applications to the OMAP35x Development Kit and test and debug 
your application under development. 

2 Development Requirements 

Your development environment must have the following items setup before proceeding with this 
application note: 

■ OMAP35x Development Kit or OMAP35x Torpedo Development Kit connected to your 
host PC through an Ethernet cable. 

■ Host PC running VS2005 with all the required service packs and QFEs. For detailed 
information on installing the necessary components, please see the OMAP35x Windows 
Embedded CE 6.0 BSP User Manual

1
 from Logic PD’s website.  

■ OMAP35x Windows Embedded CE 6.0 Source BSP release version 0.9.0 or later, 
available for download from Logic PD’s website

2
. Please see the OMAP35x Windows 

Embedded CE 6.0 BSP User Manual for important information about the BSP. 

The following required items will be discussed within this application note: 

■ CoreCon framework files (see Section 3). 

■ Software Development Kit (SDK) built from the OMAP35x Windows Embedded CE 6.0 
Source BSP (see Section 4). 

■ Your custom CE 6.0 application (see Section 5). 

3 Add Required CoreCon Files 

To establish a connection using the CoreCon framework, several component files will need to be 
copied to the OMAP35x Development Kit or built into the BSP image. The required CoreCon 
component files are: 

■ Clientshutdown.exe 

■ ConmanClient2.exe 

■ CMAccept.exe 

■ DeviceDMA.dll 

■ eDbgTL.dll 

■ TcpConnectionA.dll 

These files are installed on your development system during installation of the VS2005 
development tools.  

You only need to follow the directions in either Section 3.1 or Section 3.2; please choose the 
method that best fits your situation. 

                                                      
1
 http://support.logicpd.com/downloads/1347/ 

2
 http://support.logicpd.com/downloads/1104/ 

http://support.logicpd.com/downloads/1347/
http://support.logicpd.com/downloads/1347/
http://support.logicpd.com/downloads/1104/
http://support.logicpd.com/downloads/1347/
http://support.logicpd.com/downloads/1104/
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3.1 Copy CoreCon Files to OMAP35x Development Kit 

To copy the CoreCon files directly to your OMAP35x Development Kit, perform the following 
steps: 

1. Navigate to the following directory: 

.\Program Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\armv4i\ 

2. Copy the required files to the \Windows directory on your OMAP35x Development Kit. 

3. Proceed to Section 4. 

3.2 Build CoreCon Files into CE 6.0 Image 

To build these files directly into your CE 6.0 image, perform the following steps: 

1. Copy the required CoreCon files from the following directory: 

.\Program Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\armv4i\  

2. Copy these files to the BSP files folder on your development system located here:  

.\wince600\PLATFORM\LPD_OMAP35X_SOM\files\ 

3. In this BSP files folder on your host PC, locate the platform.bib file and open the file in a text 
editor. 

4. In the platform.bib file, find the FILES section and add the following lines of text below the 
FILES header: 

clientshutdown.exe    $(_FLATRELEASEDIR)\clientshutdown.exe     NK SH 

CMAccept.exe          $(_FLATRELEASEDIR)\CMAccept.exe           NK  

ConmanClient2.exe     $(_FLATRELEASEDIR)\ConmanClient2.exe      NK  

DeviceDMA.dll         $(_FLATRELEASEDIR)\DeviceDMA.dll          NK SH 

eDbgTL.dll            $(_FLATRELEASEDIR)\eDbgTL.dll             NK SH 

TcpConnectionA.dll    $(_FLATRELEASEDIR)\TcpConnectionA.dll     NK SH 

This snapshot shows what the file will look like after adding the lines of text. 

 

5. Close the text editor, saving your changes to the platform.bib file. 

6. Build your BSP by following the directions provided in the OMAP35x Windows Embedded CE 
6.0 BSP User Manual.  

NOTE: If your BSP has been successfully built prior to the changes listed above, using the 
Build Current BSP and Subprojects option will be sufficient.  In order to do this, select Build > 
Advance Build Commands > Build Current BSP and Subprojects.  
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4 Create an SDK in VS2005 

This section describes how to create an SDK on your VS2005 development system. If you 
already have an SDK installed on your system, proceed to Section 5. 

1. Load your OMAP35x CE 6.0 BSP into VS2005. (For detailed information on how to do this, 
please see the OMAP35x Windows Embedded CE 6.0 BSP User Manual. 

2. Select the necessary Applications and Services Development components in the BSP 
Catalog Items View window (see those items with checkmarks in the following image). 

 

3. In your VS2005 project window, right-click on SDK and select Add New SDK… 
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4. In the window that appears, fill in the fields and click OK.  

NOTE: For the purpose of these instructions, we use the name SDK1. As you encounter the 
SDK1 name within this document, please substitute it with the SDK Name you choose in this 
step. 

 

5. To build the SDK, make sure you are in the VS2005 OSDesign window. Expand the SDKs 
folder, then right-click on SDK1 and select Build. 
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6. After your SDK build has succeeded, you will need to install the MSI file created by the build. 
The SDK1.msi file location is shown in the last line of the compile. The following snapshot 
shows the SDK1.msi file is located in:  

C:\WINCE600\OSDesigns\LPD_OMAP35x_0.9.0\lpd_omap35x_0.9.0_base\SDKs\SDK1\MSI
\SDK1.msi 

 

7. Navigate to the folder where the SDK1.msi file is located and double-click SDK1.msi to start 
the installation process.  

8. When the Setup Wizard window opens, click Next to continue. 

9. In the License Agreement window, select Accept and then click Next  to continue the 
installation. 
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10. In the Customer Information window, enter your name and your organization. Then click 
Next. 

 

11. In the Choose Setup Type window, click the button next to Complete. Then click Next. 
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12. Select your desired installation path and click Next. 

 

13. In the Ready to Install window, click Install. 

14. After your SDK installation has completed, click Finish to exit the Setup Wizard. 

5 Create an Application to Debug 

This section describes how to use the VS2005 Application Wizard to create an application for 
your OMAP35x Development Kit. If you already have an application to debug, proceed to 
Section 6. 

1. Launch VS2005 on your host PC. 

2. Create a project by using the Project Design Wizard. Select File > New > Project… to launch 
the wizard. 
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3. Select the type of project you wish to create. In our example, we will select a Visual C++, 
MFC Smart Device Application. 

4. Enter the name of your project in the Name: field and click OK. 

 

5. A Welcome to the MFC Smart Device Application Wizard window will open. There are a few 
project settings to change, so click Next. 
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6. In the Platforms window, locate the Selected SDKs: section. Remove Pocket PC 2003 and 
add SDK1 to the Selected SDKs: section. Click Finish to complete the creation of your 
HelloWorld application. 

 

6 Prepare the OMAP35x Development Kit 

This section describes the steps you will need to perform on the OMAP35x Development Kit 
before establishing a connection with your VS2005 development system. 

6.1 Determine IP Address 

To setup your VS2005 development system environment, you will need to know the IP address of 
your OMAP35x Development Kit. 

1. After you have built your CE 6.0 image, boot the image on your OMAP35x Development Kit. 

2. Select Start > Run to open the Run window. 
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3. In the Open: field, type cmd and click OK. 

 

4. Type ipconfig at the \> prompt and press Enter.  

 

5. Scroll to the top of the window until you can see your IP address (in this example the IP 
address is 192.168.120.58). Write down your IP address, as you will need this information 
when setting up the connection to your VS2005 development system. 

6.2 Execute Necessary Applications 

1. Close the Command window after you have written down your IP address.  
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2. Launch Windows Explorer by selecting Start > Programs > Windows Explorer. 

 

3. Double-click on the Windows folder to open it. 

4. In the \Windows directory, double-click on ConmanClient2.exe. 
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5. Next, double-click on CMAccept.exe in the \Windows directory. 

 

7 Connect the OMAP35x Development Kit to VS2005 Development 
System 

This section describes how to configure your VS2005 development system and then connect to 
the OMAP35x Development Kit. 

7.1 Configure the VS2005 Development System 

1. To load the application you want to run and debug on the OMAP35x Development Kit, locate 
the *.sln file created for your application and double-click it (this location was set in 
Section 5). 

In our example, the HelloWorld.sln is located in the following directory: 

C:\Documents and Settings\user\My Documents\Visual Studio 2005\Projects\HelloWorld\ 
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2. In the VS2005 window that opens, set the Solution Platform to be SDK1 (ARMV4I) and the 
Target Device to be SDK1 ARMV4I Device.  

NOTE: As shown in the following snapshot, the Solution Platform is located just below the 
Help menu. 

 

3. Select Tools > Options... to access the options for this project. 
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4. To change the properties setting for the SDK1 device: 

a. In the left section, expand the Device Tools folder and click on Devices. 

b. In the top section, select SDK1 from the Show devices for platform: drop-down menu. 

c. Click Properties… 

 

5. In the Properties window, select TCP Connect Transport from the Transport: drop-down 
menu and then click Configure… 

 

6. Select Use specific IP address:. 
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7. Enter the IP address of your OMAP35x Development Kit that you wrote down in Section 6.1 
(in this example the IP address is 192.168.120.52). 

 

8. Click OK. 

7.2 Establish the Connection 

1. Back in the VS2005 window, select Tools > Connect to Device…  
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2. Verify SDK1 appears in the Platform: drop-down menu and click Connect.  

 

3. A Connecting... window will open. When Connection succeeded appears, click Close. 

 

4. At this time, you can set break points, and run and debug your application. 

8 Known Issues 

8.1 OMAP35x_WinCE600_2_1_0_Source 

Issue: When attempting to run an application the following error appears after connecting. 

1>------ Build started: Project: helloworld2, Configuration: Debug SDK2 

(ARMV4I) ------ 

1>Compiling... 

1>stdafx.cpp 

1>C:\Program Files\Windows CE 

Tools\wce600\SDK2\include\ARMV4I\shlobj.h(120) : fatal error C1083: 

Cannot open include file: 'winnetwk.h': No such file or directory 

1>Build log was saved at "file://c:\Documents and Settings\<user>\My 

Documents\Visual Studio 

http://support.logicpd.com/downloads/archives/3175/1017480_OMAP35x_WinCE600_2_1_0_Source.zip
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Solution: Copy the winnetwk.h file attached to this application note to  
C:\Program Files\Windows CE Tools\wce600\SDK1\include\ARMV4I\ NOTE: Your SDK path may 

differ from the one provided.  

9 Summary 

This application note provided instructions to setup a CoreCon communication link between the 
OMAP35x Development Kit and your Visual Studio 2005 development system. This connection 
can be used to debug and test hardware and application software. The CE 6.0 BSP and SDK 
application libraries and header files (SDK1.msi) were customized to add CoreCon component 
files. The SDK1.msi file was then used to develop a HelloWorld application. Finally, the 
OMAP35x Development Kit and the VS2005 were configured for communication and the link was 
established. 

9.1 Additional Reading 

■ Windows Embedded Blog
3
  

■ Connecting CE 6.0 Device to VS2005 Development Station
4
 

                                                      
3
 blogs.msdn.com/mikehall/archive/2006/01/03/509088.aspx 

4
 http://read.pudn.com/downloads160/ebook/721807/Connect_CE60_to_VS2005.pdf 

blogs.msdn.com/mikehall/archive/2006/01/03/509088.aspx
http://read.pudn.com/downloads160/ebook/721807/Connect_CE60_to_VS2005.pdf
http://blogs.msdn.com/mikehall/archive/2006/01/03/509088.aspx
http://read.pudn.com/downloads160/ebook/721807/Connect_CE60_to_VS2005.pdf
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//

// Copyright (c) Microsoft Corporation.  All rights reserved.

//

//

// Use of this sample source code is subject to the terms of the Microsoft

// license agreement under which you licensed this sample source code. If

// you did not accept the terms of the license agreement, you are not

// authorized to use this sample source code. For the terms of the license,

// please see the license agreement between you and Microsoft or, if applicable,

// see the LICENSE.RTF on your install media or the root of your tools installation.

// THE SAMPLE SOURCE CODE IS PROVIDED "AS IS", WITH NO WARRANTIES.

//

/*++



THIS CODE AND INFORMATION IS PROVIDED "AS IS" WITHOUT WARRANTY OF

ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND/OR FITNESS FOR A

PARTICULAR PURPOSE.



Module Name:



    winnetwk.h



Abstract:



    Standard WINNET Header File for WIN32



Notes:



        

--*/



// @CESYSGEN IF CE_MODULES_REDIR



#ifndef _WINNETWK_

#define _WINNETWK_





#ifdef __cplusplus

extern "C" {

#endif



//

// Network types

//



#define     WNNC_NET_MSNET      0x00010000

#define     WNNC_NET_LANMAN     0x00020000

#define     WNNC_NET_NETWARE    0x00030000

#define     WNNC_NET_VINES      0x00040000

#define     WNNC_NET_10NET      0x00050000

#define     WNNC_NET_LOCUS      0x00060000

#define     WNNC_NET_SUN_PC_NFS 0x00070000

#define     WNNC_NET_LANSTEP    0x00080000

#define     WNNC_NET_9TILES     0x00090000

#define     WNNC_NET_LANTASTIC  0x000A0000

#define     WNNC_NET_AS400      0x000B0000

#define     WNNC_NET_FTP_NFS    0x000C0000

#define     WNNC_NET_PATHWORKS  0x000D0000

#define     WNNC_NET_LIFENET    0x000E0000

#define     WNNC_NET_POWERLAN   0x000F0000

#define     WNNC_NET_BWNFS		0x00100000

#define     WNNC_NET_COGENT		0x00110000

#define     WNNC_NET_FARALLON	0x00120000

#define     WNNC_NET_APPLETALK	0x00130000

#define     WNNC_NET_INTERGRAPH	0x00140000





//

//  Network Resources.

//



#define RESOURCE_CONNECTED      0x00000001

#define RESOURCE_GLOBALNET      0x00000002

#define RESOURCE_REMEMBERED     0x00000003

#if(WINVER >= 0x0400)

#define RESOURCE_RECENT         0x00000004

#define RESOURCE_CONTEXT        0x00000005

#endif /* WINVER >= 0x0400 */



#define RESOURCETYPE_ANY        0x00000000

#define RESOURCETYPE_DISK       0x00000001

#define RESOURCETYPE_PRINT      0x00000002

#if(WINVER >= 0x0400)

#define RESOURCETYPE_RESERVED   0x00000008

#endif /* WINVER >= 0x0400 */

#define RESOURCETYPE_UNKNOWN    0xFFFFFFFF



#define RESOURCEUSAGE_CONNECTABLE   0x00000001

#define RESOURCEUSAGE_CONTAINER     0x00000002

#if(WINVER >= 0x0400)

#define RESOURCEUSAGE_NOLOCALDEVICE 0x00000004

#define RESOURCEUSAGE_SIBLING       0x00000008

#define RESOURCEUSAGE_ALL           (RESOURCEUSAGE_CONNECTABLE | RESOURCEUSAGE_CONTAINER)

#endif /* WINVER >= 0x0400 */

#define RESOURCEUSAGE_RESERVED      0x80000000



#define RESOURCEDISPLAYTYPE_GENERIC        0x00000000

#define RESOURCEDISPLAYTYPE_DOMAIN         0x00000001

#define RESOURCEDISPLAYTYPE_SERVER         0x00000002

#define RESOURCEDISPLAYTYPE_SHARE          0x00000003

#define RESOURCEDISPLAYTYPE_FILE           0x00000004

#define RESOURCEDISPLAYTYPE_GROUP          0x00000005

#if(WINVER >= 0x0400)

#define RESOURCEDISPLAYTYPE_NETWORK        0x00000006

#define RESOURCEDISPLAYTYPE_ROOT           0x00000007

#define RESOURCEDISPLAYTYPE_SHAREADMIN     0x00000008

#define RESOURCEDISPLAYTYPE_DIRECTORY      0x00000009

#endif /* WINVER >= 0x0400 */

#define RESOURCEDISPLAYTYPE_TREE           0x0000000A



typedef struct  _NETRESOURCEA {

    DWORD    dwScope;

    DWORD    dwType;

    DWORD    dwDisplayType;

    DWORD    dwUsage;

    LPSTR    lpLocalName;

    LPSTR    lpRemoteName;

    LPSTR    lpComment ;

    LPSTR    lpProvider;

}NETRESOURCEA, *LPNETRESOURCEA;

typedef struct  _NETRESOURCEW {

    DWORD    dwScope;

    DWORD    dwType;

    DWORD    dwDisplayType;

    DWORD    dwUsage;

    LPWSTR   lpLocalName;

    LPWSTR   lpRemoteName;

    LPWSTR   lpComment ;

    LPWSTR   lpProvider;

}NETRESOURCEW, *LPNETRESOURCEW;

#ifdef UNICODE

typedef NETRESOURCEW NETRESOURCE;

typedef LPNETRESOURCEW LPNETRESOURCE;

#else

typedef NETRESOURCEA NETRESOURCE;

typedef LPNETRESOURCEA LPNETRESOURCE;

#endif // UNICODE





//

//  Network Connections.

// 



#define NETPROPERTY_PERSISTENT       1



#define CONNECT_UPDATE_PROFILE      0x00000001

#define CONNECT_UPDATE_RECENT       0x00000002

#define CONNECT_TEMPORARY           0x00000004

#define CONNECT_INTERACTIVE         0x00000008

#define CONNECT_PROMPT              0x00000010

#define CONNECT_NEED_DRIVE          0x00000020

#if(WINVER >= 0x0400)

#define CONNECT_REFCOUNT            0x00000040

#define CONNECT_REDIRECT            0x00000080

#define CONNECT_LOCALDRIVE          0x00000100

#define CONNECT_CURRENT_MEDIA       0x00000200

#endif /* WINVER >= 0x0400 */



DWORD APIENTRY

WNetAddConnection3A(

     HWND           hwndOwner,

     LPNETRESOURCEA lpNetResource,

     LPCSTR       lpPassword,

     LPCSTR       lpUserName,

     DWORD          dwFlags

    );

DWORD APIENTRY

WNetAddConnection3W(

     HWND           hwndOwner,

     LPNETRESOURCEW lpNetResource,

     LPCWSTR       lpPassword,

     LPCWSTR       lpUserName,

     DWORD          dwFlags

    );

#ifdef UNICODE

#define WNetAddConnection3  WNetAddConnection3W

#else

#define WNetAddConnection3  WNetAddConnection3A

#endif // !UNICODE



DWORD APIENTRY

WNetCancelConnection2A(

     LPCSTR lpName,

     DWORD    dwFlags,

     BOOL     fForce

    );

DWORD APIENTRY

WNetCancelConnection2W(

     LPCWSTR lpName,

     DWORD    dwFlags,

     BOOL     fForce

    );

#ifdef UNICODE

#define WNetCancelConnection2  WNetCancelConnection2W

#else

#define WNetCancelConnection2  WNetCancelConnection2A

#endif // !UNICODE



DWORD APIENTRY

WNetGetConnectionA(

     LPCSTR lpLocalName,

     LPSTR  lpRemoteName,

     LPDWORD  lpnLength

    );

DWORD APIENTRY

WNetGetConnectionW(

     LPCWSTR lpLocalName,

     LPWSTR  lpRemoteName,

     LPDWORD  lpnLength

    );

#ifdef UNICODE

#define WNetGetConnection  WNetGetConnectionW

#else

#define WNetGetConnection  WNetGetConnectionA

#endif // !UNICODE





//

//  Network Connection Dialogs.

//





DWORD APIENTRY

WNetDisconnectDialog(

    HWND  hwnd,

    DWORD dwType

    );



#if(WINVER >= 0x0400)

typedef struct _CONNECTDLGSTRUCTA{

    DWORD cbStructure;       /* size of this structure in bytes */

    HWND hwndOwner;          /* owner window for the dialog */

    LPNETRESOURCEA lpConnRes;/* Requested Resource info    */

    DWORD dwFlags;           /* flags (see below) */

    DWORD dwDevNum;          /* number of devices connected to */

} CONNECTDLGSTRUCTA, FAR *LPCONNECTDLGSTRUCTA;

typedef struct _CONNECTDLGSTRUCTW{

    DWORD cbStructure;       /* size of this structure in bytes */

    HWND hwndOwner;          /* owner window for the dialog */

    LPNETRESOURCEW lpConnRes;/* Requested Resource info    */

    DWORD dwFlags;           /* flags (see below) */

    DWORD dwDevNum;          /* number of devices connected to */

} CONNECTDLGSTRUCTW, FAR *LPCONNECTDLGSTRUCTW;

#ifdef UNICODE

typedef CONNECTDLGSTRUCTW CONNECTDLGSTRUCT;

typedef LPCONNECTDLGSTRUCTW LPCONNECTDLGSTRUCT;

#else

typedef CONNECTDLGSTRUCTA CONNECTDLGSTRUCT;

typedef LPCONNECTDLGSTRUCTA LPCONNECTDLGSTRUCT;

#endif // UNICODE



#define CONNDLG_RO_PATH     0x00000001 /* Resource path should be read-only    */

#define CONNDLG_CONN_POINT  0x00000002 /* Netware -style movable connection point enabled */

#define CONNDLG_USE_MRU     0x00000004 /* Use MRU combobox  */

#define CONNDLG_HIDE_BOX    0x00000008 /* Hide persistent connect checkbox  */



/*

 * NOTE:  Set at most ONE of the below flags.  If neither flag is set,

 *        then the persistence is set to whatever the user chose during

 *        a previous connection

 */

#define CONNDLG_PERSIST     0x00000010 /* Force persistent connection */

#define CONNDLG_NOT_PERSIST 0x00000020 /* Force connection NOT persistent */



DWORD APIENTRY

WNetConnectionDialog1A(

    LPCONNECTDLGSTRUCTA lpConnDlgStruct

    );

DWORD APIENTRY

WNetConnectionDialog1W(

    LPCONNECTDLGSTRUCTW lpConnDlgStruct

    );

#ifdef UNICODE

#define WNetConnectionDialog1  WNetConnectionDialog1W

#else

#define WNetConnectionDialog1  WNetConnectionDialog1A

#endif // !UNICODE



typedef struct _DISCDLGSTRUCTA{

    DWORD           cbStructure;      /* size of this structure in bytes */

    HWND            hwndOwner;        /* owner window for the dialog */

    LPSTR           lpLocalName;      /* local device name */

    LPSTR           lpRemoteName;     /* network resource name */

    DWORD           dwFlags;          /* flags */

} DISCDLGSTRUCTA, FAR *LPDISCDLGSTRUCTA;

typedef struct _DISCDLGSTRUCTW{

    DWORD           cbStructure;      /* size of this structure in bytes */

    HWND            hwndOwner;        /* owner window for the dialog */

    LPWSTR          lpLocalName;      /* local device name */

    LPWSTR          lpRemoteName;     /* network resource name */

    DWORD           dwFlags;          /* flags */

} DISCDLGSTRUCTW, FAR *LPDISCDLGSTRUCTW;

#ifdef UNICODE

typedef DISCDLGSTRUCTW DISCDLGSTRUCT;

typedef LPDISCDLGSTRUCTW LPDISCDLGSTRUCT;

#else

typedef DISCDLGSTRUCTA DISCDLGSTRUCT;

typedef LPDISCDLGSTRUCTA LPDISCDLGSTRUCT;

#endif // UNICODE



#define DISC_UPDATE_PROFILE         0x00000001

#define DISC_NO_FORCE               0x00000040



DWORD APIENTRY

WNetDisconnectDialog1A(

    LPDISCDLGSTRUCTA lpConnDlgStruct

    );

DWORD APIENTRY

WNetDisconnectDialog1W(

    LPDISCDLGSTRUCTW lpConnDlgStruct

    );

#ifdef UNICODE

#define WNetDisconnectDialog1  WNetDisconnectDialog1W

#else

#define WNetDisconnectDialog1  WNetDisconnectDialog1A

#endif // !UNICODE

#endif /* WINVER >= 0x0400 */





//

//  Network Browsing.

//



DWORD APIENTRY

WNetOpenEnumA(

     DWORD          dwScope,

     DWORD          dwType,

     DWORD          dwUsage,

     LPNETRESOURCEA lpNetResource,

     LPHANDLE       lphEnum

    );

DWORD APIENTRY

WNetOpenEnumW(

     DWORD          dwScope,

     DWORD          dwType,

     DWORD          dwUsage,

     LPNETRESOURCEW lpNetResource,

     LPHANDLE       lphEnum

    );

#ifdef UNICODE

#define WNetOpenEnum  WNetOpenEnumW

#else

#define WNetOpenEnum  WNetOpenEnumA

#endif // !UNICODE



DWORD APIENTRY

WNetEnumResourceA(

     HANDLE  hEnum,

     LPDWORD lpcCount,

     LPVOID  lpBuffer,

     LPDWORD lpBufferSize

    );

DWORD APIENTRY

WNetEnumResourceW(

     HANDLE  hEnum,

     LPDWORD lpcCount,

     LPVOID  lpBuffer,

     LPDWORD lpBufferSize

    );

#ifdef UNICODE

#define WNetEnumResource  WNetEnumResourceW

#else

#define WNetEnumResource  WNetEnumResourceA

#endif // !UNICODE



DWORD APIENTRY

WNetCloseEnum(

    HANDLE   hEnum

    );





//

//  Universal Naming.

//



#define UNIVERSAL_NAME_INFO_LEVEL   0x00000001

#define REMOTE_NAME_INFO_LEVEL      0x00000002



typedef struct  _UNIVERSAL_NAME_INFOA {

    LPSTR    lpUniversalName;

}UNIVERSAL_NAME_INFOA, *LPUNIVERSAL_NAME_INFOA;

typedef struct  _UNIVERSAL_NAME_INFOW {

    LPWSTR   lpUniversalName;

}UNIVERSAL_NAME_INFOW, *LPUNIVERSAL_NAME_INFOW;

#ifdef UNICODE

typedef UNIVERSAL_NAME_INFOW UNIVERSAL_NAME_INFO;

typedef LPUNIVERSAL_NAME_INFOW LPUNIVERSAL_NAME_INFO;

#else

typedef UNIVERSAL_NAME_INFOA UNIVERSAL_NAME_INFO;

typedef LPUNIVERSAL_NAME_INFOA LPUNIVERSAL_NAME_INFO;

#endif // UNICODE



typedef struct  _REMOTE_NAME_INFOA {

    LPSTR    lpUniversalName;

    LPSTR    lpConnectionName;

    LPSTR    lpRemainingPath;

}REMOTE_NAME_INFOA, *LPREMOTE_NAME_INFOA;

typedef struct  _REMOTE_NAME_INFOW {

    LPWSTR   lpUniversalName;

    LPWSTR   lpConnectionName;

    LPWSTR   lpRemainingPath;

}REMOTE_NAME_INFOW, *LPREMOTE_NAME_INFOW;

#ifdef UNICODE

typedef REMOTE_NAME_INFOW REMOTE_NAME_INFO;

typedef LPREMOTE_NAME_INFOW LPREMOTE_NAME_INFO;

#else

typedef REMOTE_NAME_INFOA REMOTE_NAME_INFO;

typedef LPREMOTE_NAME_INFOA LPREMOTE_NAME_INFO;

#endif // UNICODE



DWORD APIENTRY

WNetGetUniversalNameA(

     LPCSTR lpLocalPath,

     DWORD    dwInfoLevel,

     LPVOID   lpBuffer,

     LPDWORD  lpBufferSize

     );

DWORD APIENTRY

WNetGetUniversalNameW(

     LPCWSTR lpLocalPath,

     DWORD    dwInfoLevel,

     LPVOID   lpBuffer,

     LPDWORD  lpBufferSize

     );

#ifdef UNICODE

#define WNetGetUniversalName  WNetGetUniversalNameW

#else

#define WNetGetUniversalName  WNetGetUniversalNameA

#endif // !UNICODE



//

//  Authentication and Logon/Logoff.

//



DWORD APIENTRY

WNetGetUserA(

     LPCSTR  lpName,

     LPSTR   lpUserName,

     LPDWORD   lpnLength

    );

DWORD APIENTRY

WNetGetUserW(

     LPCWSTR  lpName,

     LPWSTR   lpUserName,

     LPDWORD   lpnLength

    );

#ifdef UNICODE

#define WNetGetUser  WNetGetUserW

#else

#define WNetGetUser  WNetGetUserA

#endif // !UNICODE





//

//  STATUS CODES

//



// General   



#define WN_SUCCESS                      NO_ERROR

#define WN_NO_ERROR                     NO_ERROR

#define WN_NOT_SUPPORTED                ERROR_NOT_SUPPORTED

#define WN_CANCEL                       ERROR_CANCELLED

#define WN_RETRY                        ERROR_RETRY

#define WN_NET_ERROR                    ERROR_UNEXP_NET_ERR

#define WN_MORE_DATA                    ERROR_MORE_DATA

#define WN_BAD_POINTER                  ERROR_INVALID_ADDRESS

#define WN_BAD_VALUE                    ERROR_INVALID_PARAMETER

#define WN_BAD_USER                     ERROR_BAD_USERNAME

#define WN_BAD_PASSWORD                 ERROR_INVALID_PASSWORD

#define WN_ACCESS_DENIED                ERROR_ACCESS_DENIED

#define WN_FUNCTION_BUSY                ERROR_BUSY

#define WN_WINDOWS_ERROR                ERROR_UNEXP_NET_ERR

#define WN_OUT_OF_MEMORY                ERROR_NOT_ENOUGH_MEMORY

#define WN_NO_NETWORK                   ERROR_NO_NETWORK

#define WN_EXTENDED_ERROR               ERROR_EXTENDED_ERROR

#define WN_BAD_LEVEL                    ERROR_INVALID_LEVEL

#define WN_BAD_HANDLE                   ERROR_INVALID_HANDLE

#if(WINVER >= 0x0400)

#define WN_NOT_INITIALIZING             ERROR_ALREADY_INITIALIZED

#define WN_NO_MORE_DEVICES              ERROR_NO_MORE_DEVICES

#endif /* WINVER >= 0x0400 */



// Connection



#define WN_NOT_CONNECTED                ERROR_NOT_CONNECTED

#define WN_OPEN_FILES                   ERROR_OPEN_FILES

#define WN_DEVICE_IN_USE                ERROR_DEVICE_IN_USE

#define WN_BAD_NETNAME                  ERROR_BAD_NET_NAME

#define WN_BAD_LOCALNAME                ERROR_BAD_DEVICE

#define WN_ALREADY_CONNECTED            ERROR_ALREADY_ASSIGNED

#define WN_DEVICE_ERROR                 ERROR_GEN_FAILURE

#define WN_CONNECTION_CLOSED            ERROR_CONNECTION_UNAVAIL

#define WN_NO_NET_OR_BAD_PATH           ERROR_NO_NET_OR_BAD_PATH

#define WN_BAD_PROVIDER                 ERROR_BAD_PROVIDER

#define WN_CANNOT_OPEN_PROFILE          ERROR_CANNOT_OPEN_PROFILE

#define WN_BAD_PROFILE                  ERROR_BAD_PROFILE

#define WN_BAD_DEV_TYPE                 ERROR_BAD_DEV_TYPE

#define WN_DEVICE_ALREADY_REMEMBERED    ERROR_DEVICE_ALREADY_REMEMBERED



// Enumeration



#define WN_NO_MORE_ENTRIES              ERROR_NO_MORE_ITEMS

#define WN_NOT_CONTAINER                ERROR_NOT_CONTAINER



#if(WINVER >= 0x0400)

// Authentication



#define WN_NOT_AUTHENTICATED            ERROR_NOT_AUTHENTICATED

#define WN_NOT_LOGGED_ON                ERROR_NOT_LOGGED_ON

#define WN_NOT_VALIDATED                ERROR_NO_LOGON_SERVERS

#endif /* WINVER >= 0x0400 */





#if defined(UNDER_CE) && defined(WINCEOEM) && defined(WINCEMACRO)

#include <mwnetfun.h>

#endif



#ifdef __cplusplus

}

#endif



#endif  // _WINNETWK_



// @CESYSGEN ENDIF



